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Purpose

The Attorney’s User Guide provides instructions on how to use the Case Management 
Electronic Case Files (CM/ECF) system to file documents with the court. This guide also 
provides enough information to use PACER to view and retrieve docket sheets and 
documents. If more information is needed for PACER than what is provided in this guide, 
then go to the following website and review the resources provided there:

http://www.pacer.gov

Audience

The CM/ECF Attorney’s User Guide is intended for attorneys and users that file documents 
electronically to the United States Bankruptcy Court for the Southern District of Texas. This 
information may not be accurate for other districts.

Notations

The following notations are used throughout this guide:

Notation Description

This image indicates a warning message. The text that follows is in red. The 
message identifies activities that will or could cause the application to not func-
tion as expected or required.

This image indicates that important information is being provided that the 
reader should be aware of when using the application. The application will con-
tinue to function properly whether the information provided is used or not.

The light bulb indicates a tip or trick is being provided on how to use the appli-
cation to its full potential.

plain text The base font for the manual is Palatino Linotype size 11.

bolded text Dialog names are bolded.
i

http://www.pacer.gov/
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blue text Cross references to another topic in the manual are bolded and blue. Click the 
bolded, blue text to move to the cross-referenced information.

green text Image call outs are bolded and dark green in a smaller size of the base font.

text Menu items, button names, and the dialog’s field/option names are in the Times 
New Roman font, size 11, bolded, and italicized.

text » text Menu selection involving submenus use the » symbol. For example to select 
Print from the File menu, the manual will use File » Print.

value
command

When a value or command must be enter from the keyboard, the information is 
in the Arial font, size 10 and bolded.

value repvalue When the value/command contains a component that must be replaced with a 
value pertinent to your situation, that replacement is italicized. Afterwards, an 
explanation will be given like the following: 
Where repvalue is replace with ____ for your court.

 directory path When a directory path or directory path and filename are provided, the informa-
tion is in the Arial font, size 10.

filename When a filename is provided without a directory path, the filename is in the 
Arial font, size 10 and bolded.

Notation Description
ii
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Chapter 1 – Introduction to CM/ECF

Purpose This chapter provides information that an attorney needs before getting started 
using CM/ECF, including where to get help, definition of terms, system 
requirements, and other CM/ECF and PACER capabilities and registration 
information.

Chapter Topics The following topics are covered in this chapter:

• Overview, page 1 – 2

• Help Desk, page 1 – 2

• Definitions, page 1 – 2

• Systems Requirements, page 1 – 4

• CM/ECF System Capabilities, page 1 – 5

• PACER Registration, page 1 – 5
1 – 1
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Overview
Overview

This guide provides instructions on how to use the Case Management Electronic Case Files 
(CM/ECF) system to file documents with the court, or to view and retrieve docket sheets and 
documents. The screen shots that display may differ slightly as you electronically file your 
documents, due to enhancements or upgrades. 

All users should have a working knowledge of Microsoft® Internet Explorer® and Adobe® 
Acrobat®. For questions regarding these applications, please refer to their user manuals.

Before electronically filing, you should be thoroughly familiar with the following documents:

• Administrative Procedures for the Filing, Signing, and Verifying of Documents by Electronic 
Means in Texas Bankruptcy Courts

http://www.txs.uscourts.gov/attorneys/cmecf/bankruptcy/adminproc.pdf

• Local Rules

http://www.txs.uscourts.gov/bankruptcy/rulesformsproc/localrules/default.htm

Help Desk

For questions regarding this guide, CM/ECF, or filing pleadings/documents, you can contact 
the CM/ECF Help Desk at bankruptcy_ecf_helpdesk@txs.uscourts.gov or by phone at (866) 
358-6201. Support hours are Monday through Friday 8:00 a.m. to 5:00 p.m. CST. When 
sending email, include the case number.

Definitions

The following definitions are used throughout this guide:

Court For purposes of this guide, court is the United States District and 
Bankruptcy Court for the Southern District of Texas.

Electronic Filing The uploading of a pleading or document, in PDF format, directly 
from the registered user’s computer, using the Court’s Internet-based 
system to file that pleading or document in the Court’s case file. Send-
ing a document or pleading to the Court via e-mail as an attachment 
does not constitute “electronic filing.”
1 – 2
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CM/ECF Attorney’s User Guide Chapter 1 – Introduction to CM/ECF
Definitions
Electronic Filing  
System

The Court’s automated system that receives and stores documents 
which were filed in electronic form. The program is part of CM/ECF, 
which was developed for the Federal Judiciary by the Administrative 
Office of the United States Courts.

Filing User A person registered to file documents electronically with the Court. 
Filing users must be one of the following:

• Admitted to practice before the United States Bankruptcy 
Court for the Southern District of Texas and a member in good 
standing of the Court. 

• Admitted pro hac vice.

• Authorized to represent the United States of America.

OR

• Proceeding as a nonprisoner pro se litigant approved as a filing 
user by the Court. 

A filing user must receive a login and password from the Bankruptcy 
Court to use the Court’s electronic filing system.

Hyperlink A reference in a hypertext document that refers to another document 
or other resource. It is similar to a citation in literature. However, 
combined with a data network and suitable access protocol, it can be 
used to retrieve the resource referenced. A hyperlink document can 
be saved, viewed, or displayed as part of the referencing document.

Notice of Electronic 
Filing (NEF)

An electronic notice that is automatically generated by the electronic 
filing system at the time a document is docketed. The NEF includes 
the time of filing and docketing, the name of the party and filing user 
filing the document, the type of document, the text of the docket 
entry, the name of the party, and filing user receiving the notice. If a 
document is attached to the docket entry, the NEF contains a hyper-
link to the filed document allowing recipients to retrieve the docu-
ment.

PACER Public Access to Court Electronic Records (PACER) is an automated 
system allowing a user to view, print, and download Court docket 
information over the Internet. Users must register with the PACER 
Service Center at http://pacer.psc.uscourts.gov/.

Portable Document 
Format (PDF)

A document file that was either created with a word processor or was 
originally a paper document scanned and converted to a PDF file. 
Documents must be converted into PDF format to be filed electroni-
cally with the Court. These files have the file extension .pdf.
1 – 3
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Systems Requirements
Systems Requirements

The hardware and software required to electronically file, view, and retrieve case documents 
are the following:

• A computer running a standard platform such as Microsoft Windows® or a 
Macintosh® operating system.

• Adobe Acrobat or other software capable of converting documents from a word 
processor format to the portable document format (PDF)

• A PDF-compatible word processor like Macintosh or Windows based versions of 
Microsoft Word and Corel® WordPerfect®.

• A compatible Internet browser.

• Access to a scanner if non-computerized documents need to be imaged.

A scanner should only be used for documents that cannot be produced 
electronically. Scanned documents may diminish the quality of service we 
provide by slowing down the entire system. We are moving away from the 
utilization of scanned documents inside the Court and are asking you to do the 
same when possible.

Pro Se Litigant A person who represents oneself in a Court proceeding without the 
assistance of an attorney.

Scanned 
Documents

These are the paper documents that are converted to PDF via a 
scanner or multifunction copier or scanner, as opposed to converting 
an electronic document from a word processor. When scanning paper 
documents that will subsequently be filed electronically, filing users 
should configure their scanners for 300 dpi and black and white 
scanning (rather than color scanning). 

Traditional Filing/
Traditionally Filed

This is also referred to as “conventional filing,” which is submitting 
paper copies of pleadings and documents in the traditional or 
conventional manner either in person, by courier, or via United States 
Postal Service.
1 – 4
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CM/ECF System Capabilities

The electronic filing system allows registered participants with Internet accounts and 
Internet Explorer software to perform the following functions:

• Open the Court’s web page.

• View or download the most recent version of the User Guide.

• Electronically file pleadings and documents in actual (live) cases.

• Self-train on the PACER web-based tutorial.

• View official docket sheets and documents associated with cases.

• View various reports (e.g., Cases Filed Report, Calendar) for cases that were filed 
electronically.

PACER Registration

CM/ECF users must have a PACER account with the Court in order to use the Query and 
Report features of the CM/ECF system. If you do not have a PACER login, contact the PACER 
Service Center to establish an account. You may call the PACER Service Center at (800) 676-
6856 for information or to register for an account. Also, you may register for PACER online at  
http://pacer.psc.uscourts.gov/register.html. A link to PACER’s site is provided on the Court’s 
website.
1 – 5
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Chapter 2 – Working with PDF Files

Purpose This chapter provides information on the PDF file format, including how to view 
them and convert Microsoft Word and WordPerfect files to this format.

Chapter Topics The following topics are covered in this chapter:

• Setting Up Adobe Acrobat, page 2 – 2

• Portable Document Format (PDF), page 2 – 2

• How to View PDF Files, page 2 – 2

• How to Convert Documents to the PDF Format, page 2 – 4

• CM/ECF Limitation on PDF Document Size, page 2 – 5

• Common Mistakes When Filing PDF Documents, page 2 – 5

• Email Notification of Filed PDF Documents, page 2 – 6

• Certificate of Service, page 2 – 6
2 – 1
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Setting Up Adobe Acrobat
Setting Up Adobe Acrobat

Users must set up Adobe’s Acrobat Reader® or Adobe Acrobat Professional in order to view 
documents that have been electronically filed on the system. All pleadings must be filed in 
PDF format. When installing these products, please review and follow Adobe’s directions to 
use the product effectively.

Portable Document Format (PDF)

Only PDF documents may be filed with the Court using the CM/ECF system. Before sending 
the file to the Court, users should preview the PDF formatted document to ensure that it 
displays in its entirety and in the proper format. The PDF document should not include any 
embedded files like scripts, files, and executables. Filings with these embedded attachments 
will be rejected by CM/ECF. For information on PDF size limitations in CM/ECF, see page 2 – 
5.

How to View PDF Files

All PDF files can be viewed in Adobe Acrobat Reader or Adobe Acrobat Professional. There 
are two access methods upon which you can view the files.

Directly Selecting PDF Files

The fastest method for viewing a PDF file is to select the file in Explorer. When the Adobe 
Acrobat software was installed, a file association to the PDF file format should have 
automatically been set. This association allows you to double-click the PDF file to open it 
directly in Acrobat.

If the file association does not work:

1. Right-click any PDF file.

2. Select Open with » Choose default program.
2 – 2
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How to View PDF Files
The Open with dialog displays.

3. Select the Adobe Acrobat program.

4. Check the box Always use the selected program to open this kind of file.

5. Click OK.

The file association is now set for all future selections.

Selecting PDF Files within Adobe Acrobat

To select the PDF within Adobe Acrobat:

1. Open Adobe Acrobat Reader or Adobe Acrobat Professional.

2. Select File » Open.

The Windows Open dialog displays.

3. Navigate to and select the desired PDF file.

4. Click Open.

The PDF file now displays in Adobe Acrobat.
2 – 3



CM/ECF Attorney’s User Guide Chapter 2 – Working with PDF Files
How to Convert Documents to the PDF Format
Viewing Options

Once the PDF displays, there are several viewing options available depending on your 
version of Adobe Acrobat Reader or Adobe Acrobat Professional. To learn more about the 
viewing options available to you:

• Select the View menu and review the items it contains.

• Hover your cursor over the toolbar for a description of each toolbar icon.

• Select Help » Adobe Acrobat and review the online help topic Workspace » Viewing PDF 
pages.

How to Convert Documents to the PDF Format

You must convert your documents to PDF format before submitting them to the Court’s CM/
ECF system. Both Microsoft Word and WordPerfect create text searchable PDF files as 
follows:

1. Open the docu-
ment in Word or 
WordPerfect.

2. Select File tab 
and then the 
Print item.

The printing 
window 
displays.

3. For Word’s 
printer or 
WordPerfect’s 
destination 
name, select 
Adobe PDF.
2 – 4
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4. Click the Home tab to return to the document.

The document automatically adjusts to the Adobe PDF print driver settings.

5. Scroll through the document, to verify or change the formatting and location of 
section headings.

6. Select File tab and then the Print item.

The printing window displays again.

7. Click the Print button.

The Save PDF File As window displays.

8. Navigate to the folder where the PDF file should be saved.

9. Enter a file name and click Save.

A text searchable PDF file is created.

CM/ECF Limitation on PDF Document Size

The current size limitation that CM/ECF allows for electronically filed documents, including 
exhibits or attachments, is 5 megabytes. While this limit will not likely affect electronically 
created documents, in the case of imaged documents, it would be the equivalent of 
approximately 75 pages.

It is the responsibility of the filing user to ensure that PDF files meet the file size restrictions. 
Larger electronic documents must be divided into smaller PDF files. For example, an eight 
megabyte PDF file could be divided into one 5 megabyte and one 3 megabyte file.

Common Mistakes When Filing PDF Documents

Some common mistakes made when filing PDF documents include:

• Selecting the wrong PDF file to attach to a docket entry.

• Selecting the wrong document type (i.e., the original document rather than the 
converted file with the .pdf extension).
2 – 5
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• Selecting the wrong docketing event from the CM/ECF menus.

• Entering the wrong case number and not discovering the error before completing the 
transaction.

The CM/ECF system does not permit you, or the clerk’s office, to substitute or remove a 
misfiled PDF document after it has been submitted and electronically delivered to the court. 
Only the presiding judge may order the unfiling of a document once it has been filed. So, be 
careful to avoid these common mistakes.

If a mistake has been made, contact the CM/ECF Help Desk (see page 1 – 2). When calling, 
you must provide the case number and document number(s) for the docket entry or entries 
requiring correction. 

Email Notification of Filed PDF Documents

After electronically filing a PDF document, the CM/ECF system sends a Notice of Electronic 
filing (NEF) to the designated attorneys and parties who have supplied their email addresses 
to the Court. The NEF also displays the names and addresses of the individuals who will not 
be electronically notified of the filing.

It is the filer's responsibility to serve hard copies of the document and the NEF to 
attorneys and parties who are not set up for electronic notification.

Individuals who receive the NEF are permitted one “free look” at the document by clicking 
on the associated hyperlinked document number embedded in the NEF. The filer is 
permitted one free look at the document to verify that it was properly docketed. Pursuant to 
guidelines set by the Administrative Office of the U. S. Courts, the free look is available only 
once within the 15 day grace period from the date of filing.

Subsequent retrieval of the case docket sheet and document from CM/ECF must be made 
through your PACER account and is subject to regular PACER fees.

Certificate of Service

A certificate of service must be included with all filed PDF documents reflecting that service 
on known filing users will be accomplished through the NEF and indicating the manner of 
service on any party who is not a filing user. Refer to Local Rules BK LR 5005-1.
2 – 6
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Purpose This chapter describes some basic CM/ECF information, including how to log in, 
the menu items, what buttons are available for manipulating web pages, and 
finally how to verify the correct case number and your CM/ECF transactions.

Chapter Topics The following topics are covered in this chapter:

• Accessing the CM/ECF System, page 3 – 2

• The CM/ECF Menu Bar, page 3 – 6

• Manipulating Web Pages, page 3 – 7

• Verifying Case Number while Docketing, page 3 – 7

• Reviewing Your CM/ECF Transactions, page 3 – 8
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Accessing the CM/ECF System

Accessing CM/ECF not only involves logging into CM/ECF, but for some of its features, 
requires users to also log into PACER.

Logging Into CM/ECF

Users can log into the CM/ECF system via the Internet as follows:

1. Enter the following URL address into your browser:

http://www.txs.uscourts.gov/

2. Under Quick Links, click the Bankruptcy Electronic Case Filings (ECF) link.

The Attorney Admissions web page displays.

3. Click the Live Bankruptcy CM/ECF link.

The Live CM/ECF system displays.

4. Click the Southern District of Texas - Document Filing System link.

The ECF Login page displays.
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5. Either:

• Enter your CM/ECF login and password if you plan on filing documents.

OR

• Enter your PACER login and password if you plan on viewing and querying 
information.

Login names and passwords are case sensitive. 

6. Read the notice boxed in red.

7. Mark the check box within the red boxed-in notice.

8. Click Login to have the login and password validated.

If a valid login and password combination was entered, then the system displays its 
main web page (below assumes the CM/ECF information was entered). 
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You can choose any menu item from the blue menu bar along the top of the web 
page.

The date and time of your last CM/ECF log in appears at the bottom of the web 
page. You should review this each time you log in. If you suspect your last login 
date and time are incorrect, or that an unauthorized party is using your login 
and password, contact the court’s Help Desk immediately (page 1 – 2).

If an invalid login and password combination was entered, then the system responds 
with the following error message:

9. If this occurs, click Back.

The ECF Login page displays again.

10. Return to step 5 and re-enter the login and password.

Logging Into PACER

During your CM/ECF session, if you deviate from either electronically filing a document or 
maintaining your user account by selecting the Query or Report menus, the system prompts 
you for your PACER login information.

1. Select Query from CM/ECF’s web page.
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The PACER Login page displays.

WARNING: At the bottom of the PACER Login page is a Notice detailing the 
charges for using PACER.

2. Enter your PACER login and password.

3. (optional) Enter a client code.

The Client code field is an optional field which allows PACER functions to be 
tracked. It can contain up to 32 characters. If a code is entered, then it is listed on the 
billing statement generated by the PACER Service Center; otherwise, it is not on the 
statement. Because this code is optional, it must be enforced within a user’s office. 

4. (optional) Select Make this my default PACER login check box.

Choosing this check box links your PACER information to your CM/ECF login and 
password. This means you will not be required to enter you PACER information 
again while working in CM/ECF.

For information on breaking the link between the CM/ECF and PACER login 
information, see the PACER User Guide.
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5. Click Login to have PACER validate the login and password.

If a valid login and password combination was entered, then CM/ECF continues to 
the next web page in the process.

If an invalid combination was entered, then the system responds with the following 
error message:

6. If this occurs, click Back.

The PACER Login page displays again.

7. Return to step 2 and re-enter the login and password.

The CM/ECF Menu Bar

CM/ECF provides the following menu items in the top blue menu bar of every web page.

Menu Description

Bankruptcy Files electronically all bankruptcy case motions and other court documents.

Adversary Files electronically all adversary case motions and other court documents.

Query Performs queries in CM/ECF by specific case number, party name, social security 
number, or Tax ID type to retrieve documents that are relevant to the case. 

You must log into PACER before you can query CM/ECF.

Reports Retrieves docket sheets, cases-filed reports, claims register, calendar events, etc.

You must log into PACER before retrieving these reports.

Utilities Displays your personal CM/ECF transaction log and allows you to maintain your 
CM/ECF account information.

Search Searches through the CM/ECF menus and events for the specific text you enter.

Logout Exits CM/ECF and prevents further filing with your password.
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Manipulating Web Pages

The following buttons can be used to manipulate the CM/ECF web pages:

Verifying Case Number while Docketing

As you electronically file, each window displays a case number in the upper left-hand corner. 
This ensures that you are docketing to the correct case. 

If you are uncertain this is the correct case, right-click on the case number link and select 
Open in New Window to run a docket sheet for that case. You will be prompted to enter your 
PACER login and password (see page 3 – 4) before viewing the docket sheet. Once you have 
verified that this is the correct case, close the new window and return to the previous 
window.

Buttons Description

Moves the user back one web page. Internet Explorer’s back button is blue, while the 
Mozilla® Firefox® back button is slightly larger and green. Both are located in the 
browser’s upper-left corner. In both cases, you should use them to go back and correct 
an entry made on a previous web page. 

If you discover an error after the document is transmitted, contact the 
Help desk.

Clears all characters that have been entered and selections that have been made on 
the web page (i.e., it restores the web page back to its starting pointing).

Accepts all input and selections made, and then displays the next 
CM/ECF web page, if any. 

Case number
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Reviewing Your CM/ECF Transactions

If you need to check what you have done in CM/ECF, select the Utilities menu and then the 
View Your Transaction Log link (see page 7 – 4). This feature allows you to review all the 
transactions CM/ECF has processed with your login and password.

Besides just reviewing your transactions, you can use the transaction log to confirm if 
someone is using your login and password without your permission. If you suspect someone 
is using your information, immediately contact the clerk’s office. The clerk’s office will assist 
you in changing your password. If you believe that a document has been improperly filed 
with the court under your signature (i.e., your login and password is your electronic 
signature), you need to take whatever action you deem appropriate. 
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Purpose This chapter provides detailed instructions on opening a bankruptcy case and 
how to file motions in both bankruptcy and adversary cases.

Filing users should be thoroughly familiar with the document “The Filing, Signing, 
and Verifying of Documents by Electronic Means in Texas Bankruptcy Courts” before 
filing electronically. You can find this document in the following location:

http://www.txs.uscourts.gov/attorneys/cmecf/bankruptcy/adminproc.pdf

Chapter Topics The following topics are covered in this chapter:

• Opening a Bankruptcy Case, page 4 – 2

• Filing a Motion in a Bankruptcy Case, page 4 – 11
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Opening a Bankruptcy Case

This procedure describes the process for opening a voluntary bankruptcy case in CM/ECF. 

The screen images presented in this section are for informational purposes 
only. Your screen may differ from what you see in this document.

1. Log into CM/ECF (see page 3 – 2).

The CM/ECF main web page displays.

2. Select Bankruptcy from the menu bar.

The Bankruptcy Events page displays. 
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3. Click the Open Voluntary BK Case link.

The Open Voluntary Bankruptcy Case page displays.

4. Select the Chapter number from the drop-down menu.

5. Make the appropriate entries for the Joint Petition and Deficiencies fields.

6. Click Next.

The Search for a debtor subscreen displays.

7. Enter the SSN/ITIN or Tax ID/EIN information and the last or business name and 
click Search.
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If multiple entries are found, a list of names displays. Select the correct name and 
click Select name from list. If the name you are looking for is not listed, then click 
Create new party. 

If no party is found (no names display in the Party search results area), click Create 
new party. 
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Regardless if you click Create new party or Select name from list, the Debtor 
Information screen displays. 

8. Update or complete the field entries.

If creating a new party and the party has multiple SSN or Tax ID numbers, click 
the  symbol (which displays after typing within the field) to enter the 
additional numbers. You can enter up to 5 SSN and Tax ID numbers.

9. Click Submit.

The following message displays:

10. Click Next to confirm the Divisional Office.

Clicking Select name 
from list causes  
CM/ECF to enter 
data for the items 
boxed in red. These 
items cannot be 
changed.
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A subscreen of the Open Voluntary Bankruptcy Case displays requesting additional 
information.

The Fee status, Nature of debt, Estimated number of creditors, Estimated 
assets, and Estimated liabilities are required entries.

11. Enter the necessary information, then click Next.

The following notice displays:

12. Click Next.
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The Summary of Schedules subscreen displays.

13. Fill in the required fields and then click Next.
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Another subscreen of the Open Voluntary Bankruptcy Case displays.

14. Enter the required information and then click Next.

Another Open Voluntary Bankruptcy Case subscreen displays. This screen gives 
you the opportunity to attach files to the case. 

Attachments are only supported if they are in PDF file format and under a 
certain size. Review “Portable Document Format (PDF)” on page 2 – 2 and “CM/
ECF Limitation on PDF Document Size” on page 2 – 5 for an overview of PDF 
files and the size limitations.

15. Click the Browse button to locate the appropriate filename and then click Next.
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16. Select the appropriate file and click Next.

A Open Voluntary Bankruptcy Case subscreen opens. 

17. Select whether a presumption arises, then click Next.

The fee amount displays.

18. Click Next.

The following window displays requesting individuals to read a notice. 

19. To read the notice, click on the link, otherwise click Next.

20. Click Next on the following screen as well.

The following confirmation displays.
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21. Click Next.

A summary of the case is displayed. Note that a pop-up window displays showing a 
Summary of current charges. You can close the window or select Pay Now or 
Continue Filing.

Failure to pay outstanding fees may result in being temporarily locked out of the 
system and prohibited from electronic filing.
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Filing a Motion in a Bankruptcy Case

This procedure describes the process for filing a motion in a bankruptcy case. The process is 
similar for filing other bankruptcy case pleadings in CM/ECF.

The screen images presented in this section are for informational purposes 
only. Your screen may differ from what you see in this document.

To file a motion in a case:

1. Log into CM/ECF (see page 3 – 2).

The CM/ECF main web page displays.

2. Select Bankruptcy from the menu bar.
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The Bankruptcy Events page displays. 

3. Click the Motions/Applications link.

The following File a Motion page displays.

4. Enter the number of the case for which you are filing a motion.

As you enter a case number, the File a Motion page changes to the following:

5. Click Find This Case.

• If the case number is found, the File a Motion page changes to the following and 
the Next button becomes available:
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• If the case number is not found, the File a Motion page changes to the following. 
You can click the Clear button to remove your entry and start over or correct the 
entry that is already there.

• If CM/ECF finds multiple matches, the File a Motion page shows the following. 
After selecting the case you want, the Next button becomes available.

6. Click Next.

The File a Motion page changes to select the motion type.
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7. Either:

• Begin entering the event name in the text box to have CM/ECF automatically trim 
the list of available events.

OR

• Use the scroll bar to locate the event you need.

8. Select the appropriate event from the Available Events listing.

The selected event determines which web pages CM/ECF displays. 
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The selected event is placed in the Selected Events text box. For this example, 
Continue Hearing is selected.

To delete a selected event, click the event in the Selected Events text box.

9. Click Next.

The File a Motion page changes to designate the party or parties filing the 
document.

10. Click Next.
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The File a Motion screen displays with the option to Select the Party or to Add/
Create New Party.

11. In the Select the Party area, highlight the party and then click Next.

The File a Motion page changes to select the PDF document and attachment(s).

Attachments are only supported if they are in PDF file format and under a 
certain size. Review “Portable Document Format (PDF)” on page 2 – 2 and “CM/
ECF Limitation on PDF Document Size” on page 2 – 5 for an overview of PDF 
files and the size limitations.

It is imperative that you attach an electronic 
copy of the actual pleading when prompted 
by the system. Failure to do so causes CM/
ECF to display the error message shown to 
the right.
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12. For the Main Document, click Browse.

The Windows Choose File dialog displays.

13. Navigate to and select the PDF file to upload.

The selected PDF must meet CM/ECF size limitations (page 2 – 5).

You must select a PDF file. Selecting another file format causes CM/ECF to display 
the following error message after clicking the Next button:

If you receive this message, click the Back button and select a PDF formatted file.
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14. (optional) Verify you selected the correct document by right-clicking it and selecting 
Open or Open with Acrobat (whichever is available). 

The PDF file opens in Acrobat. Once verified, close Acrobat.

15. Click Open.

CM/ECF inserts the PDF file name and location in the File a Motion page.

If there are no attachments to the motions, select the No option (default) to the 
Attachments to Document: and click Next, then skip the next step. If there are 
attachments, continue to the next step. The procedure to add attachments is similar 
to adding the main document. 
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16. (optional) Add an attachment as follows:

a. After adding the PDF file, select the Yes option to the Attachment to Document: 
option, then click Next.

The options screen for the attachment displays.

b. Click Browse.

The Windows Choose File dialog displays.

c. Navigate to and select the PDF file to upload.

The PDF must meet CM/ECF size limitations (page 2 – 5).

d. Click Open.
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CM/ECF inserts the PDF file name and location in the File a Motion page. 

e. You must:

• Use the Category pull-down menu to select the attachment type.

AND/OR

• Enter a clear and concise description for the attachment.

f. Click Add to List to save the file to be attached. If more files are required, then click 
Browse again and repeat the steps to add files to the list.

17. Click Next.
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In our example, we are filing a motion to continue hearing. The File a Motion page 
changes to select the category to which your event relates.

18. Highlight the event (in this example, misc) and click Next.

The following screen displays to select the appropriate event.

This is the last opportunity to abort the CM/ECF filing, which can be done by 
clicking on any CM/ECF menu item or clicking the browser’s back button until 
you reach the beginning of the event.

19. Confirm the appropriate event is checked off, then click Next.
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The screen updates to allow you to modify the docket text.

20. From the drop-down menu, select the appropriate entry and click Next. In this 
example, Amended was selected.

The final docket text screen displays.

This is the last opportunity to abort the CM/ECF filing, which can be done by clicking on 
any CM/ECF menu item or clicking the browser’s back button until you reach the 
beginning of the event.

21. Click Next to file and docket the pleading.

After processing, CM/ECF displays the Notice of Electronic Filing (NEF).
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The NEF confirms that CM/ECF has registered your transaction and that the 
pleading is now an official Court document. It also displays the date and time of 
your transaction and the number that was assigned to your document(s). You should 
note the number(s) on the PDF file(s).

22. Select the browser’s Print icon to print the document receipt. 

23. Select File » Save As to save the receipt to a file on you PC.

The NEF is your confirmation that the filing was accepted.

If you are not familiar with email notifications, see page 2 – 6.
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Purpose This chapter provides information on how you can query the CM/ECF database 
for information. Included are some sample queries to help you get started.

Chapter Topics The following topics are covered in this chapter:

• Accessing Query Mode, page 5 – 2

• Sample Queries, page 5 – 3

• Case Query Page, page 5 – 6
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Accessing Query Mode

CM/ECF allows registered participants to query its system for specific case information. 

To enter the query mode of CM/ECF:

1. Select Query from the menu bar.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 4 for instructions).

3. Click Login.
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After a successful PACER login, CM/ECF displays the Query page.

Sample Queries

The following are but a few sample queries to get you started using the Query page. They are 
not meant to be an all inclusive list.

No Search Criteria

Even though the Run Query button is immediately available, clicking it before entering 
criteria for the query produces the following error messages:

If you receive this message, click your browser’s back button to return to the Query page. 
Afterwards, enter some criteria before clicking the Run Query button again.
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Search by Case Number

To search CM/ECF based on a case number:

1. Enter your case number.

2. Click Run Query.

A Query page displays listing the case information you can view.

From this page you can click on the information you want to see. For further details on this 
page, see “Case Query Page” on page 5 – 6.
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Search by Name

To search CM/ECF based on a party or attorney name:

1. Enter the last name of the party (or attorney) in the appropriate field.

2. Click Run Query.

If more than one person with that name exists in the CM/ECF database, a page 
displays listing all the matches.

3. Click on the appropriate case number.

A query page that is similar to the Query page that displayed for the case number query 
displays. For further details on this page, see “Case Query Page” on page 5 – 6.
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Once you have used CM/ECF query mode to find the case you need, the following Query 
page displays. 

At the top of the page CM/ECF displays the case number, case style, presiding judge, date 
that the initial case was filed. If the case is closed it will also list the terminated date. You can 
choose specific case information from a large list of query options by simply clicking on the 
appropriate hyperlink name.

The following are a few samples of the type of information you can view. They are not meant 
to be an all inclusive list.
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Attorney Information

To obtain attorney information, click the Attorney link. CM/ECF displays the names, 
addresses, and telephone numbers of the attorneys who represent each of the case parties.
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Case Summary Information

To obtain summary information on the case, click the Case Summary link. CM/ECF displays a 
summary of the current case.
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 Deadline/Schedule Information

To obtain information on the deadlines and hearings on the case:

1. Click the Deadline/Schedule link.

The page below displays allowing you to query CM/ECF to obtain hearings and 
other schedule deadlines. 

2. Use the drop-down menus to select how the information should be sorted.

3. Click Run Query.

The Deadline/Schedule page sorts and displays the deadlines and hearings per your 
selection.

Clicking on a blue underlined document number causes CM/ECF to display that document 
when you have permissions to view it. Clicking on a gray sphere causes CM/ECF to display 
the docket information and related docket entries for the hearing you selected.
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Docket Information

To obtain a docket sheet:

1. Click the Docket Report link.

The Docket Sheet page displays allowing you to decide what CM/ECF should 
include on the docket sheet report.

Leaving the range fields blank causes CM/ECF to display the entire docket 
sheet.

2. (optional) Select a date range for the report.

3. (optional) Select a range of docketing numbers.

4. (optional) Mark the options you wish to include on the docket sheet.

Terminated parties is selected by default.

5. (optional) Change any other options on the page as you deem appropriate.

6. Click Run Report.
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CM/ECF runs and displays your customized docket sheet.

Clicking on a blue underlined document number causes CM/ECF to display that document 
when you have permissions to view it. Clicking on a gray sphere causes CM/ECF to display 
the Notice of Electronic Filing (NEF).
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Purpose This chapter provides information on how to access and run the reports provided 
by CM/ECF.

Chapter Topics The following topics are covered in this chapter:

• Accessing the Reports, page 6 – 2

• Sample Reports, page 6 – 3
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Accessing the Reports

To access the reports available in CM/ECF

1. Select Reports from the menu bar.

CM/ECF displays the Reports page.

2. Click the report link for the report you want to run.

The following reports require you to log into PACER:

• Cases

• Claims Register

• Creditor Mailing Matrix

• Docket Activity

• Docket Report

• Judgment Index

3. If the PACER Login page displays, enter your PACER login and password (see page 
3 – 4 for instructions).

What displays next depends on the selected report. For more information, see the sample 
reports section that follows.
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The following are sample reports that you can run from CM/ECF.

Docket Sheet

To run a docket sheet report:

1. Click the Docket Report link.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 4 for instructions).

After a successful PACER login, CM/ECF displays the Docket Sheet page. 

3. Enter the case number for the docket sheet you want to view.
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The Docket Sheet page changes to include a button for finding the case.

4. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Run Report button becomes available after a unique case number is found or 
after you select a case from the matched listing.

5. (optional) Customize your docket sheet by designating:

• A document range. (Leaving the documents blank means to include all of them.)

• The items to include. (Terminated parties is selected by default.)

• Document, format, and sort by options.

6. Click Run Report.
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CM/ECF runs and displays your customized docket sheet.

Clicking on a blue underlined document number causes CM/ECF to display that document 
when you have permissions to view it. If you chose Links to Notices of Electronic Filing, 
then clicking on a gray sphere causes CM/ECF to display the Notice of Electronic Filing 
(NEF).
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Cases

To run a bankruptcy cases report:

WARNING: This report queries ALL bankruptcy cases for information that matches 
your criteria. Therefore your criteria could produce many pages of information for 
which you will be billed. 
 
If you want information for a single bankruptcy case, use the menu options Query or 
Reports » Docket Report.

1. Click the Cases link.

The PACER Login page displays.

2. Enter your PACER login and password (see page 3 – 4 for instructions).

After a successful PACER login, CM/ECF displays the Cases Report page.
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3. Enter your criteria for generating the report.

4. Click Run Report.

CM/ECF runs and displays the Cases Report.
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Calendar Events

To run a calendar events report:

1. Click the Calendar Events link.

CM/ECF displays the Calendar Events page.

2. Enter a date range for the report.

This is the only required input for the report.

3. (optional) Enter remaining criteria as deemed appropriate for your report.

4. Click Run Report.
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Sample Reports
CM/ECF runs and displays the Calendar Events Report.
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Sample Reports
Written Opinions

This report shows you any opinion that has been loaded on the CM/ECF system by the 
Chambers of the Bankruptcy Judges for the Southern District of Texas.

To view a written opinion:

1. Click the Written Opinions link.

CM/ECF displays the Written Opinions Report page.

2. Enter a date range for the report.

This is the only required input for the report.

3. (optional) Enter remaining criteria as deemed appropriate for your report.

4. Click Run Report.

CM/ECF runs and displays the Written Opinions Report.
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The Utilities Menu
Chapter 7 – The Utilities Menu

Purpose This chapter provides information on how to access and run the utilities provided 
by CM/ECF.

Chapter Topics The following topics are covered in this chapter:

• Accessing the Utilities, page 7 – 2

• Your Account Utilities, page 7 – 3

• Miscellaneous Utilities, page 7 – 9
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Accessing the Utilities

The CM/ECF utilities provide the means for registered users to maintain their account in 
CM/ECF and to view all of their CM/ECF transactions.

To access the utilities feature:

1. Select Utilities from the menu bar.

CM/ECF displays the Utilities page.

2. Click the link for the utility you want to use.

What displays next depends on the selected utility.
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Your Account Utilities

The links in this section pertain to the user’s CM/ECF or PACER account.

Maintain Your ECF Account

This utility allows you to update your email account, address, phone information, and other 
personal information. 

To use this utility:

1. Click the Maintain Your ECF Account link.

The Maintain User Account page displays.

2. Change any data as required.

3. (optional) Click Email information to change or add email addresses.

4. (optional) Click More user information to change login and password information.

5. Click Submit to accept changes.
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View Your Transaction Log

This utility allows you to review all the transactions CM/ECF has processed with your login 
and password. If you believe or suspect someone is using your login and password without 
permission, change your password immediately, then email the Court’s Help Desk as soon as 
possible (page 1 – 2).

To use this utility:

1. Click the View Your Transaction Log link.

The View Transaction Log page displays.

2. Enter the date range for your report.

3. Click Submit.

CM/ECF displays the Transaction Log of all your transactions within the date range 
you specified.
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Change Client Code

This utility allows PACER users to change the client code, which is used for identifying 
charges made to the current PACER account.

If the user has a PACER preference set (via the PSC website) which requires a client 
code in a specific format, in order to change the client code, you must follow the 
designated format.

To use this utility:

1. Click the Change Your Client Code link.

The following page displays.

2. Enter a new or changed client code.

3. Click Submit to accept changes.

Change Your PACER Account

This utility allows the user to enter a different PACER login and password.

To use this utility:

1. Click the Change Your PACER Account link.

The PACER Login screen displays.

2. Enter the new PACER login and password.

For details on logging into PACER, see page 3 – 4.

3. Click Login.

CM/ECF displays the message PACER user changed indicating that the change has been 
accepted.
7 – 5



CM/ECF Attorney’s User Guide Chapter 7 – The Utilities Menu
Your Account Utilities
Review Billing History

This utility displays the number of CM/ECF pages accessed and the charges incurred for the 
PACER account currently being used. If client codes are entered when CM/ECF is accessed, 
the charges are totaled for each code.

To use this utility:

1. Click the Review Billing History link.

The PACER CASE SEARCH SIGN IN page displays.

2. Enter your PACER login and password.

3. (optional) Enter a client code.

4. Click Login.
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Your Account Utilities
The PACER BILLING HISTORY page displays.

5. Enter the date range for your report.

6. (optional) Set other options per your requirements.

7. Click Submit Form.
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Your Account Utilities
The BILLING HISTORY report displays.

 View PACER Account Information

This utility displays the current PACER login ID and client code. To use this utility, click the 
View PACER Account Information link.

CM/ECF displays the following:
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Remove Default PACER Account

This utility removes the link between the current CM/ECF user account and the associated 
default PACER account. To use this utility, click the Remove Default PACER Account link.

CM/ECF displays the following:

Miscellaneous Utilities

The links in this section are those that do not pertain to the user’s CM/ECF or PACER 
account.

Internet Payment History

This utility allows users to review the credit card payments made for electronic filing.

To use this utility:

1. Click the Internet Payment History link.

The Internet Payment History page displays.

2. Enter the date range for your report.

3. Click Run Report.

The credit card transactions for the designated time period displays.
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Mailings

This utility allows users to find out who receives email notices, who requires manual 
noticing, and to print mailing labels.

To use this utility:

1. Click the Mailings link.

The Mailings page displays.

2. Click the link for the information you need.

Mailing Info for a Case

This link provides a list of people who receive email notices and the people who require 
manual noticing.

1. From the Mailings page, click Mailing Info for a Case.

The Mailing Information for a Case page displays.

2. Enter your case number.

The Mailing Information for a Case page changes to include a button for finding the 
case.

3. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Submit button becomes available after a unique case number is found or after 
you select a case or cases from the matched listing.
7 – 10



CM/ECF Attorney’s User Guide Chapter 7 – The Utilities Menu
Miscellaneous Utilities
4. Click Submit.

The Mailing Information for a Case page displays.

Creditor Mailing Matrix

This link provides the ability to print mailing labels for a designated case.

1. From the Mailings page, click Creditor Mailing Matrix.

The Creditor Mailing Matrix page displays.

2. Enter your case number.
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The Creditor Mailing Matrix page changes to include a button for finding the case.

3. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Run Report button becomes available after a unique case number is found or 
after you select a case or cases from the matched listing.

4. Select the Format then click Run Report.

The PACER Service Center Transaction Receipt displays.

5. Click View Labels to continue.
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Verify a Document

This utility verifies that the electronic signature of a document is the same as when the 
document was filed. If it is different, the document may have been altered.

To use this utility:

1. Click the Verify a Document link.

The Verify Document(s) page displays.

2. Enter your case number.

The Verify Document(s) page changes to include a button for finding the case.

3. Click Find This Case.

As previously illustrated when filing documents, CM/ECF will let you know if the 
case number is found, not found, or if multiple case numbers match your entry.

The Next button becomes available after a unique case number is found or after you 
select a case or cases from the matched listing.
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4. Enter your document number.

5. Click Next.

The utility verifies the signature on the document and displays the following 
information:
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